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📘 Chapter 1: Introduction to Computers 

🔹 1.1 History and Evolution of Computers 
 

🕰️ What is the History of Computers? 
The history of computers tells us how computing machines were developed over time, 
starting from simple counting tools to the modern smart computers we use today. 

Let’s explore it step by step. 

 

🧮 Early Calculating Devices 
Before modern computers, people used simple tools to perform calculations. 

✅ 1. Abacus (about 3000 BC) 

●​ First known calculating tool​
 

●​ Invented in China​
 

●​ Used beads on rods to add and subtract numbers​
 🧠 Example: Like a manual calculator made of beads. 
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 ​
 

 

✅ 2. Napier’s Bones (1617) 

●​ Invented by John Napier, a Scottish mathematician​
 

●​ Used for multiplication and division​
 

●​ Made of rods with numbers engraved on them​

 

 

✅ 3. Slide Rule (1620) 

●​ Invented by William Oughtred​
 

●​ Used for multiplication, division, and square roots​
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●​ Used by engineers before calculators were invented​

 

 

✅ 4. Pascal’s Calculator (1642) 

●​ Invented by Blaise Pascal, a French scientist​
 

●​ First mechanical calculator​
 

●​ Could do addition and subtraction 

​
 

 

✅ 5. Leibniz’s Machine (1671) 

●​ Invented by Gottfried Wilhelm Leibniz​
 

●​ Improved Pascal’s calculator​
 

●​ Could perform multiplication and division 
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​
 

 

✅ 6. Analytical Engine (1837) 

●​ Designed by Charles Babbage, called the Father of Computers​
 

●​ Could perform any calculation​
 

●​ Had features like input, memory, processor, and output​
 🧠 Important: It was never built fully, but the idea was the foundation of modern 
computers.​

 

 

💻 Evolution of Modern Computers 
As technology improved, computers became faster, smaller, and more powerful. The history is 
divided into five generations: 
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🧾 1st Generation (1940–1956) – Vacuum Tubes 

●​ Used vacuum tubes for processing​
 

●​ Very large, hot, and slow​
 

●​ Example: ENIAC (Electronic Numerical Integrator and Computer)​
 

●​ Stored programs in punch cards​

 

 

🧾 2nd Generation (1956–1963) – Transistors 

●​ Used transistors instead of vacuum tubes​
 

●​ Smaller, faster, and more reliable​
 

●​ Less electricity used​
 

●​ Example: IBM 1401​
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🧾 3rd Generation (1964–1971) – Integrated Circuits (IC) 

●​ Transistors were combined into IC chips​
 

●​ Computers became even smaller and cheaper​
 

●​ Could run multiple programs​
 

●​ Example: IBM 360 

​
 

 

🧾 4th Generation (1971–Present) – Microprocessors 

●​ Introduction of microprocessor (chip with all computer functions)​
 

●​ Computers became personal, portable, and affordable​
 

●​ Started the PC revolution​
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●​ Examples: Intel processors, IBM PC​

 

 

🧾 5th Generation (Present & Future) – Artificial Intelligence (AI) 

●​ Focus on AI, robotics, machine learning​
 

●​ Computers can think, learn, and solve problems​
 

●​ Voice recognition, self-driving cars, chatbots​
 

●​ Examples: Siri, Google Assistant, ChatGPT​

 

 

📌 Summary Table 
Generation Technology Used Features Example 

1st Vacuum Tubes Big, slow, very hot ENIAC 

2nd Transistors Smaller, faster, less heat IBM 1401 

3rd Integrated Circuits More powerful, cheaper IBM 360 
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4th Microprocessors Personal computers, laptops Intel-based 
PCs 

5th Artificial Intelligence Smart devices, learning 
computers 

Siri, ChatGPT 

 

 

 

 

🔹 1.2 Hardware Components 

Input Devices | Output Devices | System Unit | Storage Devices | Communication Devices 

 

🖥️ What is Hardware? 
Hardware refers to the physical parts of a computer — the parts you can see and touch, like 
the keyboard, mouse, screen, or CPU. 

🧠 Simple definition: Hardware is everything in the computer that you can hold in your hand. 

Hardware is divided into five main types: 

 

🔹 1. Input Devices 
Input devices are used to enter data into the computer. 

🧠 Simple idea: You use input devices to tell the computer what to do. 

✅ Common Input Devices: 

Device Use 

Keyboard Typing letters, numbers, commands 

Mouse Pointing, clicking, selecting items 
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Microphone Recording your voice 

Scanner Converting paper pictures into digital form 

Webcam Capturing live video and images 

Touchscree
n 

Allows touch input directly on screen 

 

 

 

🔹 2. Output Devices 
Output devices show the results of the computer's work. 

🧠 Simple idea: Output devices show you what the computer has done. 

✅ Common Output Devices: 

Device Use 

Monitor Shows text, pictures, and videos 

Printer Prints text or images on paper 

Speakers Play sound and music 

Headphone
s 

Allow you to hear sound privately 

Projector Displays screen on a big 
wall/screen 

 

🔹 3. System Unit 
The system unit is the main part of the computer that does all the processing. 

🧠 It is the "brain box" of the computer — often called the CPU box. 
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🔧 It contains: 

Component Function 

Processor 
(CPU) 

Processes data; acts like the "brain" 

Motherboard Connects all computer parts 

RAM (Memory) Stores running programs temporarily 

Power Supply Provides electricity to the 
components 

Ports Used to connect external devices 

 

🔹 4. Storage Devices 
Storage devices are used to save data for later use. 

🧠 Simple idea: They are like the memory or locker of the computer. 
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✅ Types of Storage Devices: 

Device Use 

Hard Disk Drive (HDD) Main storage; stores all files 

Solid State Drive (SSD) Faster and modern type of storage 

USB Flash Drive Portable storage for easy transfer 

CD/DVD Optical storage for music, videos, 
data 

Memory Card Used in phones, cameras, tablets 

 

🔹 5. Communication Devices 
These devices help computers to send and receive data over networks like the internet. 

🧠 Simple idea: These are the devices that allow computers to talk to each other. 

✅ Common Communication Devices: 

Device Use 

Modem Connects computer to the internet 

Network Card Used to connect to local networks (LAN) 

Wi-Fi Adapter Connects to wireless internet 

Bluetooth 
Device 

Shares files wirelessly between devices 

 

📌 Summary Table: 
Hardware Type Examples 

Input Devices Keyboard, mouse, microphone 

Output Devices Monitor, printer, speakers 
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System Unit CPU, RAM, motherboard, ports 

Storage Devices Hard drive, USB, memory card 

Communication 
Devices 

Modem, network card, Wi-Fi adapter 

 
 

🔹 1.3 Computer Software 

System Software | Application Software | Installing and Running Software 

 

💡 What is Software? 
Software is a set of instructions or programs that tell the computer what to do. 

🧠 Simple Definition:​
 Software is like the brain of the computer — it tells the hardware how to work. 

 

🔄 Types of Software: 

Software is mainly divided into two main types: 

 

🔹 1. System Software 
System software is the software that runs the computer system itself.​
 It controls the hardware and provides a platform to run other programs. 

✅ Examples: 

●​ Operating Systems like Windows, Linux​
 

●​ Utility Programs like Antivirus, Disk Cleanup​
 

●​ Device Drivers that help connect hardware (printer, mouse, etc.)​
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🔧 Functions of System Software: 

●​ Starts the computer (booting)​
 

●​ Manages files and folders​
 

●​ Controls hardware (CPU, memory, input/output)​
 

●​ Helps application software to run​
 

●​ Keeps the system secure and up to date​
 

🧠 Example: When you switch on your computer, Windows (system software) loads first before 
anything else. 

 

🔹 2. Application Software 
Application software is the software used to perform specific tasks on a computer. 

✅ Examples: 

Task Software Example 

Writing Microsoft Word 

Calculations Microsoft Excel 

Making presentations PowerPoint 

Drawing or editing photos Paint, Photoshop 

Browsing internet Google Chrome, 
Firefox 

Watching videos VLC Media Player 

🧠 Simple Rule:​
 System software runs the computer,​
 Application software lets you use the computer. 
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🔹 Installing and Running Software 

🧩 What is Installation? 

Installing software means putting a new program into the computer so that it can be used. 

✅ How to Install Software: 

1.​ Insert a CD, USB, or download from the internet​
 

2.​ Open the setup file (usually named setup.exe)​
 

3.​ Follow the instructions and click Next > Next > Finish​
 

4.​ After installation, the software icon appears on the desktop or Start menu​
 

 

▶️ Running Software: 

To run or open software: 

●​ Click on the program icon on the desktop or in the Start Menu​
 

●​ The program opens and is ready to use​
 🧠 Example: Clicking on the MS Word icon opens Word so you can type.​
 

 

🧽 Uninstalling Software: 

If you no longer need a program: 

●​ Go to Control Panel > Programs > Uninstall a Program​
 

●​ Select the software and click Uninstall​
 

 

 

14 

http://thetmnotes.com


Th
eT
mN
ote
s.c
om

Introduction to Information & Communication Technologies (ICT) By TheTmNotes.com 
 

 

📌 Summary Table: 
Type Function Examples 

System Software Runs and manages computer 
hardware 

Windows, Linux 

Application Software Helps user perform tasks Word, Excel, Chrome 

Installing Adding new software to the system Using setup file 

Running Opening and using the software Clicking on program 

 
 

🔹 What is a Program? 
A program is a set of instructions written for the computer to perform a specific task. 

🧠 Simple Definition:​
 A program tells the computer what to do and how to do it. 

✅ Examples of Programs: 

Task Program Name 

Writing a letter Microsoft Word 

Calculating numbers Calculator 

Browsing the internet Google Chrome 

Watching videos VLC Media Player 

Each program is created using a programming language. 
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🔹 What is Software Development? 
Software development is the process of creating computer programs or software. 

🧠 Simple Idea: Software development means making a new app or program using a 
computer language. 

 

🔄 Steps in Software Development Process: 
The process of making software involves several clear steps. These steps are called the 
Software Development Life Cycle (SDLC). 

 

✅ 1. Problem Identification 

●​ Understand what the user wants​
 

●​ Ask: What is the problem? What task should the software do?​
 

🧠 Example: A school wants a program to make student report cards. 

 

✅ 2. Planning and Designing 

●​ Plan how the program will work​
 

●​ Design the screens, buttons, layout, and flow of actions​
 

🧠 Like drawing a map before starting a journey 

 

✅ 3. Coding / Programming 

●​ Write the actual program using a programming language​
 

●​ Examples of programming languages: C, C++, Python, Java​
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🧠 This is like writing instructions in a language the computer understands 

 

✅ 4. Testing 

●​ Check the program for errors or bugs​
 

●​ Make sure everything works correctly​
 

🧠 Just like testing a machine before selling it 

 

✅ 5. Documentation 

●​ Write a guide about how to use the software​
 

●​ Helps the users and future developers​
 

🧠 Like a manual that comes with a new mobile phone 

 

✅ 6. Installation and Use 

●​ Install the program on computers​
 

●​ Now the users can start using it​
 

 

✅ 7. Maintenance 

●​ Fix any new bugs or errors​
 

●​ Add new features if needed​
 

🧠 Software is updated regularly to keep it working well 
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📌 Summary Table 
Term Meaning 

Program Set of instructions for the computer 

Software Development Process of creating a program 

Programming 
Language 

Language used to write programs (C, Python) 

Coding Writing instructions using programming language 

Testing Finding and fixing errors 

Maintenance Keeping the software updated and bug-free 

 

🔹 1.5 Computer Types 

Personal Computers | Desktop Computers | Mobile Devices | Embedded Computers | 
Game Consoles | Servers | Thin Clients | Mainframes | Supercomputers 

 

🧠 What are Computer Types? 
Computers come in different shapes and sizes, depending on how they are used.​
 Some are used by individuals, some by organizations, and some are used for very large 
tasks like in space research or banks. 

 

🔹 1. Personal Computers (PC) 
A Personal Computer (PC) is made for individual use. 

🧠 Simple Definition: A computer that only one person uses at a time. 

✅ Examples: 

●​ Desktop computers​
 

18 

http://thetmnotes.com


Th
eT
mN
ote
s.c
om

Introduction to Information & Communication Technologies (ICT) By TheTmNotes.com 
 

 
●​ Laptops​

 

 

🔹 2. Desktop Computers 
●​ These are non-portable PCs kept on a desk​

 
●​ Used in homes, offices, schools​

 
●​ Have separate monitor, CPU, keyboard, and mouse​

 

🧠 Example: The computer in a school’s computer lab. 

 

🔹 3. Mobile Computing Devices 
These are portable computers — easy to carry and use anywhere. 

✅ Types: 

Device Use 

Laptop Full computer, foldable 

Tablet Touchscreen, no keyboard 

Smartphon
e 

Pocket-sized, phone + 
computer 

🧠 Example: A student using a tablet for online classes. 

 

🔹 4. Embedded Computers 
●​ Tiny computers built inside machines​

 
●​ Do one specific task only​
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●​ Cannot be used for other work​

 

 

✅ Found in: 

Device Purpose 

Microwave oven Controls heating 

Washing 
machine 

Controls wash cycles 

Cars Controls engine functions 

🧠 Example: The chip inside an automatic washing machine. 

 

🔹 5. Game Consoles 
●​ Special computers used for playing video games​

 
●​ Connects to TV or monitor​

 
●​ Comes with controllers​

 

✅ Examples: 

●​ PlayStation​
 

●​ Xbox​
 

●​ Nintendo Switch​
 

🧠 Used mostly by children and gamers at home. 

 

🔹 6. Servers 
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●​ A powerful computer that provides services to other computers​

 
●​ Stores and manages files, emails, websites, printers, and data​

 
●​ Used in offices, schools, and data centers​

 

🧠 Example: Your school may have a server for all students' files. 

 

🔹 7. Thin Clients 
●​ A simple, less powerful computer​

 
●​ Depends on a server for most work​

 
●​ Cannot work alone without a server​

 

🧠 Example: Used in banks, call centers, or labs with many users. 

 

🔹 8. Mainframe Computers 
●​ Very large and powerful computers​

 
●​ Can handle thousands of users at once​

 
●​ Used by big businesses, banks, and government offices​

 

🧠 Example: A bank uses a mainframe to process millions of transactions daily. 

 

🔹 9. Supercomputers 
●​ The fastest and most powerful computers in the world​
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●​ Used for complex tasks like weather forecasting, scientific research, and space 

missions​
 

🧠 Example: NASA uses supercomputers to control spacecrafts and predict climate. 

 

📌 Summary Table 
Type Used For Power Portable? 

Personal Computer Daily personal use (office/home) Medium Yes/No 

Desktop Office, school labs Medium ❌ No 

Mobile Devices On-the-go computing Medium ✅ Yes 

Embedded 
Computer 

Inside machines (microwave, 
car) 

Low ❌ No 

Game Console Playing games Medium ❌ No 

Server Managing network services High ❌ No 

Thin Client Depends on server Low ✅ Yes 

Mainframe Banks, large companies Very High ❌ No 

Supercomputer Research, weather, science Ultra High ❌ No 

 
 

🔹 1.6 Computer Applications 

Education | Finance | Government | Health Care | Science | Publishing | Travel | 
Manufacturing​
 For DIT Students – Matric Level 

 

💡 What are Computer Applications? 
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Computer applications are the different areas of life where computers are used to perform 
tasks, save time, improve work, and increase accuracy. 

🧠 Simple Definition:​
 Computer applications mean how and where computers are used in daily life and work. 

 

 

🔹 1. Education 
Computers help in teaching and learning.​
 Students can learn online, watch videos, take quizzes, and do research. 

✅ Examples: 

●​ Online classes (Zoom, Google Classroom)​
 

●​ Educational videos and tutorials​
 

●​ Computer labs in schools​
 

●​ E-books and digital libraries​
 

🧠 Benefit: Makes learning easy, fast, and fun. 

 

🔹 2. Finance 
Computers are used in banks and financial institutions to manage money, accounts, and 
transactions. 

✅ Examples: 

●​ ATM machines​
 

●​ Online banking​
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●​ Account record keeping​

 
●​ Stock market tracking​

 

🧠 Benefit: Helps in fast and secure money management. 

 

🔹 3. Government 
Governments use computers for record keeping, online services, and communication. 

✅ Examples: 

●​ NADRA ID registration system​
 

●​ Online bill payments​
 

●​ E-Government portals​
 

●​ Voter lists and national databases​
 

🧠 Benefit: Improves transparency and public service speed. 

 

🔹 4. Health Care 
Computers help doctors and hospitals in patient care and medical research. 

✅ Examples: 

●​ Storing patient records​
 

●​ Medical test machines (X-rays, MRI)​
 

●​ Online appointments​
 

●​ Health monitoring apps​
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🧠 Benefit: Helps in better and faster treatment. 

 

🔹 5. Science 
Scientists use computers for research, analysis, and simulations. 

✅ Examples: 

●​ Weather forecasting​
 

●​ Space missions (NASA, satellites)​
 

●​ Scientific experiments and simulations​
 

●​ DNA and genetic research​
 

🧠 Benefit: Allows accurate experiments and data analysis. 

 

🔹 6. Publishing 
Computers help in writing, designing, and printing books, newspapers, and magazines. 

✅ Examples: 

●​ Writing in Microsoft Word​
 

●​ Designing in Adobe InDesign or Canva​
 

●​ Printing with digital printers​
 

●​ Creating e-books​
 

🧠 Benefit: Speeds up content creation and publishing process. 

 

🔹 7. Travel 
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Computers are used in the travel and tourism industry for planning, booking, and managing 
trips. 

✅ Examples: 

●​ Online ticket booking (airlines, buses, trains)​
 

●​ Hotel reservations​
 

●​ GPS and maps (Google Maps)​
 

●​ Flight and train schedules​
 

🧠 Benefit: Makes travel planning easier and faster. 

 

🔹 8. Manufacturing 
In factories, computers control machines and robots, improve production, and check quality. 

✅ Examples: 

●​ Automated production lines​
 

●​ Quality checking systems​
 

●​ Inventory and stock management​
 

●​ Robotics in assembly​
 

🧠 Benefit: Increases production speed and product quality. 

 

📌 Summary Table 
Area How Computers Help 

Education Online learning, tutorials, e-books 
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Finance Online banking, ATM, account records 

Government ID systems, records, online services 

Health Care Patient data, test machines, online 
appointments 

Science Research, simulations, weather forecasting 

Publishing Writing, editing, designing, printing 

Travel Ticket booking, GPS, schedules 

  

 
 
 

📘 Chapter 2: SYSTEM UNIT COMPONENTS  

  

2.1 The Motherboard 
The motherboard is the main circuit board of the computer.​
 It acts like the “central hub” that connects all components together. 
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Main Functions: 

●​ Holds the CPU, memory (RAM), and other essential chips.​
 

●​ Provides connectors for storage devices, graphics cards, and other expansion cards.​
 

●​ Allows communication between all hardware components.​
 

Main Parts of the Motherboard: 

●​ CPU Socket – Where the processor is installed.​
 

●​ RAM Slots – Hold memory modules.​
 

●​ Expansion Slots – For graphics cards, sound cards, etc.​
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●​ Chipset – Controls data flow between CPU, memory, and peripherals.​

 
●​ Power Connectors – Supply electricity to components.​

 

 

2.2 Processor (CPU) 
The Central Processing Unit is often called the “brain of the computer.”​
 It processes instructions and controls the operation of the computer. 

 

Main Parts of the CPU: 

1.​ The Control Unit (CU)​
 

○​ Directs the flow of data and instructions.​
 

○​ Tells other parts of the computer what to do.​
 

○​ Acts like a manager, ensuring every part works in sync.​
 

2.​ The Arithmetic Logic Unit (ALU)​
 

○​ Performs mathematical operations (addition, subtraction, multiplication, division).​
 

○​ Handles logical comparisons (e.g., greater than, equal to).​
 

○​ Works closely with the CU to process data.​
 

 

Machine Cycle 
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The process the CPU follows to execute an instruction is called the machine cycle.​
 It has four steps: 

1.​ Fetch – Get the instruction from memory.​
 

2.​ Decode – Interpret the instruction.​
 

3.​ Execute – Perform the operation.​
 

4.​ Store – Save the result in memory if needed.​
 

 

The System Clock 

●​ A tiny quartz crystal on the motherboard that produces a regular beat (measured in 
Hertz).​
 

●​ Controls the timing of all computer operations.​
 

●​ A faster clock speed means the CPU can process more instructions per second.​
 

 

Comparison of PC Processors 

Processor 
Type 

Example Speed Use 

Single-core Intel Pentium 4 Slower Basic tasks 

Dual-core Intel Core 2 Duo Faster Multitasking 

Quad-core Intel Core i5 Even 
faster 

Gaming, heavy tasks 

Octa-core AMD Ryzen 7 Very fast Video editing, 3D rendering 

 

2.3 Memory 
Memory in a computer is like a human brain—it stores data and instructions so that the 
processor can use them to perform tasks. Without memory, a computer cannot work. 
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Bits and Bytes 

●​ Bit​
 

○​ The smallest unit of data in a computer.​
 

○​ It can store only 0 or 1 (binary system).​
 

○​ Example: 1 bit can represent on (1) or off (0).​
 

●​ Byte​
 

○​ A group of 8 bits.​
 

○​ One byte can store one character (like the letter A or the number 5).​
 

○​ Example: The word CAT is stored as 3 bytes (one byte for each letter).​
 

 

Addressing 

●​ Each storage location in the computer's memory has a unique address.​
 

●​ This address helps the computer find and retrieve data quickly.​
 

●​ Think of it like house numbers in a street—each house has a unique address so the 
postman can deliver letters to the right place.​
 

 

Types of Memory 

1. RAM (Random Access Memory) 

●​ Temporary storage.​
 

●​ Stores data and programs while the computer is running.​
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●​ All data is lost when the computer is turned off (volatile memory).​

 
●​ Example: When you open MS Word, it loads into RAM so it can work fast. 

 

​
 

2. ROM (Read-Only Memory) 

●​ Permanent storage.​
 

●​ Stores essential instructions needed to start the computer (booting).​
 

●​ Data in ROM cannot be changed easily.​
 

●​ Example: BIOS (Basic Input/Output System) is stored in ROM. 

​
 

3. Cache Memory 

●​ Very fast small memory located close to the processor.​
 

32 

http://thetmnotes.com


Th
eT
mN
ote
s.c
om

Introduction to Information & Communication Technologies (ICT) By TheTmNotes.com 
 

 
●​ Stores frequently used data so the CPU does not have to fetch it from RAM repeatedly.​

 
●​ Makes the computer faster.​

 

4. Flash Memory 

●​ A type of non-volatile memory (data is not lost when power is off).​
 

●​ Used in USB drives, memory cards, and SSDs.​
 

●​ Example: A pen drive storing your pictures. 

 

 

 

​
 

5. CMOS (Complementary Metal-Oxide Semiconductor) 

●​ Stores system settings like date, time, and hardware configuration.​
 

●​ Uses a small battery to keep data when the computer is turned off. 
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​
 

 

✅ Example to Remember:​
 If a computer was a student: 

●​ RAM = notebook for today’s class (temporary, can erase)​
 

●​ ROM = printed school rules (permanent)​
 

●​ Cache = sticky notes with quick reminders (very fast to access)​
 

●​ Flash Memory = USB storing assignments (portable)​
 

●​ CMOS = settings for alarms and timetable 

2.4 Expansion Slots, Adapter Cards and Drive Bays 

Expansion Slots 

●​ Definition: Expansion slots are long, narrow connectors found on the motherboard.​
 

●​ Purpose: They allow you to add extra hardware components (adapter cards) to improve 
the computer’s capabilities.​
 

●​ Examples of use:​
 

○​ Adding a graphics card for better video performance.​
 

○​ Adding a sound card for high-quality audio.​
 

○​ Adding a network card for internet and LAN connectivity. 
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​
 

Common Types of Expansion Slots: 

1.​ PCI (Peripheral Component Interconnect) – Used for older sound and network cards.​
 

2.​ PCI Express (PCIe) – Faster slots used for modern graphics cards.​
 

3.​ AGP (Accelerated Graphics Port) – Older slot mainly for graphics cards.​
 

4.​ M.2 slots – Used for modern SSDs and wireless cards.​
 

 

Adapter Cards 

●​ Definition: Adapter cards are electronic circuit boards that plug into expansion slots.​
 

●​ Purpose: They add new features or improve the performance of a computer. 

​
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●​ Examples:​

 
1.​ Video Card (Graphics Card): Improves graphics quality for gaming, video 

editing, and high-resolution display.​
 

2.​ Sound Card: Provides better audio quality.​
 

3.​ Network Interface Card (NIC): Connects the computer to wired or wireless 
networks.​
 

4.​ TV Tuner Card: Allows you to watch and record television on your computer.​
 

 

Drive Bays 

●​ Definition: Drive bays are spaces inside the computer case where storage drives and 
other devices are installed. 

​
 

●​ Types of Drive Bays:​
 

1.​ External Drive Bays: Accessible from the outside of the computer case.​
 

■​ Example: CD/DVD drives, Blu-ray drives.​
 

2.​ Internal Drive Bays: Located inside the case, not directly accessible.​
 

■​ Example: Hard Disk Drives (HDDs) and Solid-State Drives (SSDs).​
 

Drive Bay Sizes: 
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●​ 5.25-inch bays: Used for CD/DVD/Blu-ray drives.​

 
●​ 3.5-inch bays: Used for traditional hard drives and floppy drives (older computers).​

 
●​ 2.5-inch bays: Common for laptop hard drives and SSDs.​

 

 

✅ In Short: 

●​ Expansion Slots = Pathways for adding hardware.​
 

●​ Adapter Cards = Hardware that fits into slots to add new features.​
 

●​ Drive Bays = Spaces to install drives and storage devices. 

2.5 Ports and Connectors 
A port is a connection point on a computer or device where you can plug in cables or other 
devices.​
 A connector is the actual plug that fits into a port.​
 Think of it like a door (port) and a key (connector) — they fit together to let data or power pass 
through. 

Common Types of Ports and Connectors 

1. USB (Universal Serial Bus) 

●​ Purpose: Used to connect many devices like a mouse, keyboard, pen drive, printer, 
camera, and mobile phone.​
 

●​ Features:​
 

○​ Can transfer data.​
 

○​ Can provide power to small devices.​
 

○​ New versions (USB 3.0, USB-C) are faster and smaller. 
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​
 

2. VGA (Video Graphics Array) 

●​ Purpose: Connects a computer to a monitor or projector.​
 

●​ Features:​
 

○​ Transfers video signals only (no audio).​
 

○​ Usually blue in color with 15 pins.​
 

○​ Mostly used in older computers and projectors. 

​
 

3. HDMI (High Definition Multimedia Interface) 

●​ Purpose: Connects computers, TVs, and projectors for both video and audio in high 
quality.​
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●​ Features:​

 
○​ Supports HD and 4K video.​

 
○​ One cable for both sound and video.​

 
○​ Common in modern laptops, gaming consoles, and TVs.​

 

 

4. Audio Ports 

●​ Purpose: For connecting speakers, headphones, or microphones.​
 

●​ Features:​
 

○​ Usually color-coded:​
 

■​ Green: Headphones/Speakers​
 

■​ Pink: Microphone​
 

■​ Blue: Line-in​
 

○​ Some devices use a single 3.5mm jack for both mic and headphones. 
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​
 

5. Network Port (Ethernet Port) 

●​ Purpose: Connects a computer to a network (LAN) using a network cable.​
 

●​ Features:​
 

○​ Looks like a big telephone port (RJ-45).​
 

○​ Used for fast and stable internet connections. 

​
 

6. FireWire (IEEE 1394) 

●​ Purpose: Used to connect digital cameras, external hard drives, and other high-speed 
devices.​
 

●​ Features:​
 

○​ Very fast for transferring large video and audio files.​
 

○​ Not very common now, replaced by USB and Thunderbolt. 
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​
 

 

2.6 Power Supply 
The Power Supply Unit (PSU) is the part of a computer that provides the right amount of 
electrical power to all components. 

 

How it Works 

●​ Electricity from the wall socket is AC (Alternating Current).​
 

●​ The power supply converts it to DC (Direct Current) which computers can use.​
 

●​ It distributes power to the motherboard, hard drives, fans, and other components.​
 

Main Parts of a Power Supply 

●​ Fan: Keeps the power supply cool.​
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●​ Connectors: Different cables that plug into parts of the computer.​

 
●​ Switch: Turns the power on/off.​

 

Types of Power Supply 

1.​ AT Power Supply: Used in older computers.​
 

2.​ ATX Power Supply: Standard in modern PCs.​
 

Why It’s Important 

●​ Without a power supply, a computer cannot run.​
 

●​ If it fails, it can damage other parts.​
 

●​ Choosing the right wattage is important (e.g., gaming PCs need more power). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

📘 Chapter 3: Input & Output Devices 
 

🔹 3.1 What is Input? 
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🔸 Input means giving data or instructions to the computer.​
 We use different devices to send commands or enter data into the computer. These are called 
input devices. 

🧠 Example: 

●​ When you type on a keyboard, you are giving input.​
 

●​ When you move the mouse, you are also giving input.​
 

🟢 Definition:​
 Input is the process of entering data and instructions into a computer using input devices. 

 

🔹 3.2 Keyboard and Pointing Devices 

Let’s understand the most common input devices. 

 

✅ Keyboard 

●​ A keyboard is the most commonly used input device.​
 

●​ It has buttons called keys.​
 

●​ Each key is used to type letters, numbers, and symbols.​
 

●​ It also has special keys like Enter, Backspace, Shift, Ctrl, Alt, Spacebar, etc.​
 

🧠 Example: You use the keyboard to type a letter or fill a form. 
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✅ Pointing Devices 

These devices are used to move a pointer (cursor) on the screen. They are helpful in 
selecting, clicking, and dragging items. 

 

🖱️ Mouse 

●​ A mouse is a small hand-held device.​
 

●​ It has buttons (usually left and right) and a scroll wheel.​
 

●​ When you move the mouse, the pointer moves on the screen.​
 

●​ You can click, double-click, right-click, and drag items.​
 

🧠 Used in: Opening files, selecting text, drawing. 

 

 

🎮 Joystick 

●​ A joystick is a stick-like device that moves in different directions.​
 

●​ Mostly used to play video games.​
 

●​ It helps control objects in games like cars, airplanes, etc.​
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🧠 Example: Used in flight simulators and racing games. 

 

 

🌀 Trackball 

●​ A trackball looks like a mouse, but instead of moving the whole device, you roll a ball 
on top of it.​
 

●​ The cursor moves based on the direction of the ball.​
 

●​ It stays in one place and is used in laptops or special equipment.​
 

🧠 Used where space is limited. 

 

 

✋ Touchpad 
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●​ A touchpad is a flat surface found on laptops.​

 
●​ You move your finger on it to move the pointer.​

 
●​ Tapping it is the same as clicking a mouse.​

 

🧠 Example: Found below the keyboard on laptops. 

 

🔹 3.3 Touch Screen, Pen and Stylus 
 

🔹 3.4 Other Types of Input 

 

 

🔹 3.3 Touch Screen, Pen, and Stylus 
 

✅ Touch Screen 

●​ A touch screen is a screen you can touch with your finger to give commands.​
 

●​ It works like both an input and output device. You see information (output) and touch 
it (input).​
 

●​ No need for a keyboard or mouse.​
 

46 

http://thetmnotes.com


Th
eT
mN
ote
s.c
om

Introduction to Information & Communication Technologies (ICT) By TheTmNotes.com 
 

 
🧠 Example: Smartphones, tablets, ATMs, ticket machines. 

📌 Use: Tap, swipe, zoom, drag with fingers. 
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✅ Digital Pen and Stylus 

✏️ Pen Input (Digital Pen / Light Pen) 

●​ A digital pen is an electronic pen used to write or draw on special screens or tablets.​
 

●​ It converts handwriting into digital form.​
 

🧠 Example: Used in graphic designing, signing digital documents. 

 

 

✍️ Stylus 

●​ A stylus is a small, pen-like tool used to tap, draw, or write on a touchscreen.​
 

●​ It is more accurate than using a finger.​
 

🧠 Example: Used on tablets and smartphones, especially by designers and students. 
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🔹 3.4 Other Types of Input 

There are many more input devices for special purposes. Let’s explore them. 

 

🎮 Game Controllers 

●​ Used to control video games.​
 

●​ Includes gamepads, joysticks, steering wheels, etc.​
 

●​ Has buttons and sticks to control characters or vehicles.​
 

🧠 Example: PlayStation or Xbox controllers. 
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📷 Digital Cameras 

●​ A digital camera takes photos or records videos.​
 

●​ The images are stored in digital format.​
 

●​ When connected to a computer, the photos can be used or edited.​
 

🧠 Used in: Photography, video recording, online content creation. 

 

 

🎤 Voice Input (Microphone) 

●​ A microphone is used to record sound or give voice commands.​
 

●​ Voice is converted into digital signals the computer can understand.​
 

🧠 Example: Voice search on Google, giving commands to Alexa or Siri. 
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📄 Scanners 

●​ A scanner copies images or documents and converts them into digital format.​
 

●​ It creates a soft copy of your paper document.​
 

🧠 Example: Scanning a photo to upload it online. 

 

 

🔐 Biometric Devices 

●​ These devices use unique human features to identify people.​
 

●​ Examples: Fingerprint scanners, face recognition, retina scanners.​
 

●​ Used for security and attendance.​
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🧠 Example: Unlocking a phone using fingerprint or face. 

 

 

🖥️ Terminals 

●​ A terminal is a computer or device that is used to enter or receive data from a central 
system.​
 

●​ Common types:​
 

○​ ATM terminals – for banking.​
 

○​ POS terminals – used in shops for billing.​
 

🧠 Example: Entering PIN at an ATM, scanning items at a store. 

 

🔹 3.5 What is Output? 

🔸 After we give input and the computer processes it, the result is called output. 

🟢 Definition:​
 Output is the result produced by the computer after processing the input.​
 We can see, hear, or feel the output through output devices. 

 

🧠 Examples of Output: 

●​ Seeing a picture on the screen​
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●​ Hearing a song from speakers​

 
●​ Getting a printed page from the printer​

 

 

🖥️ Common Output Devices: 

●​ Monitor (for visuals)​
 

●​ Printer (for paper copies)​
 

●​ Speakers (for sound)​
 

 

🔹 3.6 Display Devices 

A display device shows the output in visual form (pictures, text, video). 

 

✅ CRT Monitors (Cathode Ray Tube) 

●​ Old type of monitor, big and heavy like a TV.​
 

●​ Uses electrons and a glass screen to show the image.​
 

●​ Not used much today because they take more space and electricity.​
 

🧠 Example: The old computer labs in schools. 
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✅ LCD/LED Monitors 

💻 LCD (Liquid Crystal Display): 

●​ Thin and light monitor.​
 

●​ Uses liquid crystals and a light source to display pictures.​
 

●​ Uses less power than CRT.​
 

●​ Common in offices and homes. 

​
 

 

💡 LED (Light Emitting Diode): 
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●​ A type of LCD monitor but uses LED lights.​

 
●​ Brighter and clearer than normal LCD.​

 
●​ Uses even less electricity.​

 
●​ Longer life and better display. 

​
 

 

🆚 CRT vs LCD/LED Comparison Table 

Feature CRT Monitor LCD/LED Monitor 

Size & Weight Large and 
heavy 

Thin and lightweight 

Power Consumption High Low 

Picture Quality Lower Sharper and brighter 

Usage Old computers Modern computers 

 

🔹 3.7 Printers 

A printer is an output device that gives you a hard copy — this means printing the data on 
paper. 

🧠 Example: You write a document on a computer and want it on paper — the printer does this 
job. 
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✅ Types of Printers 

Printers are mainly divided into two types: 

 

🔸 1. Impact Printers 

●​ These printers strike (hit) the paper using a ribbon to print.​
 

●​ They are noisy and slower.​
 

●​ Mostly used in banks or offices for multiple copies (like carbon copies).​
 

🧠 Example: Dot Matrix Printer 

 

 

🔸 2. Non-Impact Printers 

●​ These printers do not touch the paper directly.​
 

●​ They are quieter and faster.​
 

●​ Most modern printers are non-impact.​
 

🧠 Example: Inkjet, Laser Printers 
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✅ Common Types of Printers 
 

🖨️ Inkjet Printer 

●​ Sprays tiny drops of ink onto the paper.​
 

●​ Prints in color or black & white.​
 

●​ Good for home and school use.​
 

●​ Slower than laser but cheaper.​
 

 

🔆 Laser Printer 

●​ Uses a laser beam and toner powder.​
 

●​ Fast and high-quality print.​
 

●​ Best for offices and business.​
 

●​ More expensive than inkjet but faster and more durable.​
 

 

🖨️ Multifunction Printer (All-in-One) 

57 

http://thetmnotes.com


Th
eT
mN
ote
s.c
om

Introduction to Information & Communication Technologies (ICT) By TheTmNotes.com 
 

 
●​ This printer can:​

 
○​ Print​

 
○​ Scan​

 
○​ Photocopy​

 
○​ Sometimes Fax​

 
●​ Saves space and money.​

 
●​ Common in homes and small offices.​

 

 

🔥 Thermal Printer 

●​ Uses heat to print on special paper.​
 

●​ No ink is needed.​
 

●​ Quiet and fast.​
 

●​ Used in shops, ATMs, billing machines.​
 

🧠 Example: Receipt printers 

 

🖊️ Plotters 

●​ Special printers for large-size drawings like:​
 

○​ Maps​
 

○​ Blueprints​
 

○​ Engineering designs​
 

●​ Used by architects, engineers, and designers.​
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●​ Very accurate and prints in detail. 

​
 

 

🖼️ Large Format Printers 

●​ Used to print big posters, banners, signs.​
 

●​ Can print on plastic, cloth, or vinyl.​
 

●​ Common in advertising and graphic design.​
 

 
 

🔹 3.8 Other Output Devices 

Besides monitors and printers, computers use other output devices to show sound, images, 
and video. These devices help in hearing and presenting information. 

Let’s explore them one by one: 

 

🔊 1. Speakers 

●​ Speakers are output devices that produce sound.​
 

●​ They are connected to the computer or built into laptops.​
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●​ Used to play music, sound effects, videos, or system sounds.​

 

🧠 Examples: Used in classrooms, homes, or during presentations. 

 

🎧 2. Headphones 

●​ Headphones are small speakers worn on the ears.​
 

●​ They are used when you want to listen privately without disturbing others.​
 

●​ Some headphones also have microphones for voice input.​
 

🧠 Examples: Listening to lectures, music, or attending online classes. 

 

📽️ 3. Multimedia Projectors 

●​ A projector is a device that shows the computer screen on a wall or big screen.​
 

●​ Used to show videos, slides, documents to a large audience.​
 

●​ Common in classrooms, seminars, offices, and events.​
 

🧠 Examples: Teachers showing a presentation to students. 

 

🧑‍🏫 4. Interactive Whiteboards 

●​ An interactive whiteboard looks like a smart board.​
 

●​ It works like a touch screen connected to a computer and projector.​
 

●​ Teachers and students can touch, write, draw, and control the computer directly from 
the board.​
 

●​ Used for interactive learning and teaching.​
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🧠 Examples: Used in modern classrooms to make learning more fun and digital. 

 
 
 

📘 Chapter 4: Digital Storage 

🔹 4.1 Hard Disks 
 

💿 What is a Hard Disk? 

A hard disk (also called a hard drive or HDD) is the main storage device in a computer. It is 
used to store all the software, documents, pictures, videos, and the operating system. The 
data on a hard disk remains saved even when the computer is turned off. This is called 
permanent storage. 

 

✅ Characteristics of a Hard Disk 

Let’s explore some important features of hard disks: 

1.​ Storage Capacity​
 

○​ Hard disks can store a large amount of data.​
 

○​ Common sizes are 500 GB, 1 TB, 2 TB, etc.​
 

○​ (1 GB = 1,000 megabytes, 1 TB = 1,000 GB)​
 

2.​ Speed (RPM)​
 

○​ Hard disks contain spinning disks inside.​
 

○​ Speed is measured in RPM (Revolutions Per Minute).​
 

○​ Common speeds: 5400 RPM (slower), 7200 RPM (faster).​
 

○​ A higher RPM means faster data access.​
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3.​ Data Access Time​

 
○​ Time taken to read or write data.​

 
○​ Faster access time = better performance.​

 
4.​ Non-Volatile Storage​

 
○​ Data is not lost when the power goes off.​

 
○​ This makes it different from RAM (temporary memory).​

 
5.​ Magnetic Storage​

 
○​ Hard disks use magnetic material to store data. 
○​  

​
 

 

🖥️ Internal vs. External Hard Disks 

Type Description Example Use 

Internal Hard 
Disk 

Installed inside the computer. Stores the operating 
system, apps, and data. 

Used in desktops and 
laptops 

External Hard 
Disk 

A portable drive that connects via USB. Used for 
backup or extra storage. 

Carry files, transfer 
data 

🔹 Internal HDD is not usually removed.​
 🔹 External HDD can be carried easily and used with many computers. 
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🧰 RAID (Redundant Array of Independent Disks) 

●​ RAID is a special system that connects two or more hard disks together.​
 

●​ It is used to improve speed, storage size, and data safety.​
 

●​ If one disk fails, the other can still work. This is helpful for data backup.​
 

🧠 Used in: Servers, business computers, data centers. 

Types of RAID: 

●​ RAID 0 – Combines storage for better speed, but no backup.​
 

●​ RAID 1 – Makes an exact copy of data on another disk (backup).​
 

●​ RAID 5 – Combines speed and backup. 

​
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🌐 NAS (Network Attached Storage) 

●​ NAS is a storage device connected to a network.​
 

●​ It allows many users to store and access files over Wi-Fi or LAN.​
 

●​ NAS works like a mini-server for saving and sharing data.​
 

🧠 Used in: Schools, offices, homes for shared access and data storage. 

Benefits of NAS: 

●​ Centralized file storage​
 

●​ File sharing between multiple users​
 

●​ Data backup and security 

 

 

 

🔹 4.2 Flash Storage 
 

💡 What is Flash Storage? 

Flash storage is a modern type of storage that saves data using electronic chips instead of 
moving parts. It is faster, lighter, and more durable than traditional hard disks. 

Flash storage is called non-volatile, meaning it keeps data saved even when power is off. 
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💾 1. Solid State Drives (SSD) 

An SSD (Solid State Drive) is a modern version of a hard disk. It uses flash memory to store 
data. Unlike HDDs, SSDs have no moving parts, which makes them much faster and more 
reliable. 

✅ Features: 

●​ Very fast speed – loads files and programs quickly​
 

●​ No noise – no spinning disk inside​
 

●​ More durable – less chance of damage if dropped​
 

●​ Expensive – usually costs more than HDDs​
 

🧠 Used in: Laptops, modern PCs, mobile devices, gaming systems 

Example: 

If your computer has an SSD, it can start up in 10 seconds, while an HDD may take 30–40 
seconds. 
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💳 2. Memory Cards 

Memory cards are small, portable flash storage devices often used in mobile phones, digital 
cameras, tablets, and MP3 players. 

✅ Types: 

●​ SD Card (Secure Digital)​
 

●​ MicroSD Card (smaller version for phones)​
 

●​ CF Card (Compact Flash)​
 

✅ Features: 

●​ Small and lightweight​
 

●​ Easy to insert or remove​
 

●​ Can store photos, videos, apps, and files​
 

🧠 Used in: Cameras, smartphones, tablets, handheld gaming devices 
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🔌 3. USB Flash Drives (Pen Drives) 

A USB flash drive (also known as a pen drive) is a small, portable device used to transfer and 
store data. It connects to the computer using a USB port. 

✅ Features: 

●​ Very easy to carry in your pocket​
 

●​ No external power needed​
 

●​ Can store a wide range of files​
 

●​ Common sizes: 4 GB, 8 GB, 16 GB, 32 GB, 64 GB, 128 GB, etc.​
 

🧠 Used by students and teachers to carry assignments, presentations, or software. 
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🧩 4. Express Card Modules 

Express Cards are special types of flash storage mainly used in older laptops to add extra 
memory or storage. They are inserted into the ExpressCard slot of a laptop. 

✅ Features: 

●​ Provide additional storage or support devices like network cards​
 

●​ Not commonly used in modern laptops (replaced by USB or built-in SSDs)​
 

🧠 Used in: Older laptops or professional devices before USB became common. 

 

 

🔹 4.3 Optical Storage 
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💿 What is Optical Storage? 

Optical storage refers to a method of saving data using light (laser technology). In this 
storage type, data is written and read using a laser beam. The data is stored on a round 
plastic disc. 

Optical discs are often used for music, videos, games, software, and backups. 

 

 

🔘 1. CD (Compact Disc) 

A CD (Compact Disc) is a flat, round disc that can store up to 700 MB of data. That’s enough 
for about 80 minutes of audio or hundreds of text files. 

✅ Features: 

●​ Diameter: 12 cm​
 

●​ Stores music, text files, small software​
 

●​ Common types:​
 

○​ CD-ROM – Read-only (cannot write)​
 

○​ CD-R – Can write once​
 

○​ CD-RW – Can erase and reuse​
 

🧠 Used in: Audio albums, small games, old software 
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🔘 2. DVD (Digital Versatile Disc or Digital Video Disc) 

A DVD looks just like a CD but can hold much more data — usually 4.7 GB on a single layer, 
and up to 8.5 GB on a dual-layer DVD. 

✅ Features: 

●​ Stores videos, larger software, operating systems​
 

●​ Better quality than CDs​
 

●​ Common types:​
 

○​ DVD-ROM – Read-only​
 

○​ DVD-R / DVD+R – Write once​
 

○​ DVD-RW / DVD+RW – Rewritable​
 

🧠 Used in: Movies, video games, software, backup 
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🔘 3. Blu-ray Disc 

Blu-ray is the latest and most advanced form of optical storage. It uses a blue laser (instead of 
red like in CDs and DVDs), allowing it to store much more data — up to 25 GB on a single 
layer and 50 GB on a dual layer. 

✅ Features: 

●​ High-definition video and large data files​
 

●​ Very clear video and sound quality​
 

●​ More expensive than DVDs and CDs​
 

🧠 Used in: HD movies, PS3/PS4 games, large backups 
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🔹 4.4 Magnetic Tape Storage 

💡 What is Magnetic Tape? 

Magnetic tape is a type of storage that stores data using magnetized plastic tape, similar to 
how cassette tapes store sound. It is one of the oldest storage methods but is still used 
today for special purposes. 

 

✅ Features of Magnetic Tape: 

●​ Made of plastic ribbon coated with magnetic material​
 

●​ Data is read and written using a tape drive​
 

●​ Stores a large amount of data at low cost​
 

●​ Very slow to access specific data (sequential access)​
 

🧠 Used in: 

●​ Backups in big companies​
 

●​ Archives of old data​
 

●​ Libraries, research centers, banks​
 

 

📦 Advantages: 

●​ Cheap for storing huge data​
 

●​ Good for long-term storage​
 

●​ Can store terabytes of data​
 

⚠️ Disadvantages: 
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●​ Very slow compared to hard drives or flash​

 
●​ Needs special equipment to read/write​

 
●​ Not good for regular daily use​

 

 

🧭 Example: 

A bank may use magnetic tapes to back up daily transactions at the end of each day. 

 

🔹 4.5 Cloud Storage 

💡 What is Cloud Storage? 

Cloud storage means storing your data on remote servers (computers) that are accessed over 
the Internet. The data is saved in data centers and can be accessed from any device, 
anytime, anywhere with an internet connection. 

 

 

✅ Features of Cloud Storage: 

●​ No physical device needed​
 

●​ Data is stored safely on the internet​
 

●​ Offers backup, sharing, and real-time access​
 

●​ You can access files on mobile, tablet, laptop, or PC​
 

🧠 Used in: 

●​ Google Drive, Dropbox, OneDrive​
 

●​ Storing documents, photos, videos​
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●​ School, office, business, and personal use​

 

 

📦 Advantages: 

●​ Access data from anywhere​
 

●​ Easy to share files with others​
 

●​ Automatic backup of important data​
 

●​ Saves space on your computer or phone​
 

⚠️ Disadvantages: 

●​ Requires internet connection​
 

●​ Data may be unsafe if account is hacked​
 

●​ Free storage is limited (extra costs for more space)​
 

 

 

🌐 Real-Life Examples: 

Cloud Service Free Storage 
Offered 

Google Drive 15 GB 

Dropbox 2 GB 

Microsoft OneDrive 5 GB 
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📘 Chapter 5: System Software 

🔹 5.1 Operating Systems 
 

💡 What is an Operating System? 

An Operating System (OS) is the main software that controls and manages the entire 
computer. It acts like a bridge between the user and the hardware. 

Without an operating system, a computer cannot work. 
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🧠 Think of It Like This: 

If the computer is a machine, the operating system is its brain.​
 It helps you run programs, use the keyboard and mouse, view files, and connect to the internet. 

 

✅ Main Functions of an Operating System: 

1.​ Manages Hardware​
 It controls all devices like CPU, RAM, hard disk, keyboard, printer, etc.​
 

2.​ Runs Programs​
 It loads and runs software like MS Word, Chrome, games, etc.​
 

3.​ User Interface​
 It gives you a way to interact with the computer, like a desktop, icons, and buttons.​
 

4.​ File Management​
 Helps you create, open, save, and delete files and folders.​
 

5.​ Memory Management​
 It decides which program gets how much memory (RAM).​
 

6.​ Multitasking​
 Allows you to run more than one program at a time.​
 

 

🖥️ Types of Operating Systems: 

Type Description Examples 

GUI (Graphical User 
Interface) 

Uses pictures, icons, windows, and 
buttons. Easy to use. 

Windows, macOS, 
Android 

CUI (Command User 
Interface) 

You type commands to control the 
computer. Text-based. 

MS-DOS, Linux 
(terminal) 

Single-user OS One person uses the computer at a time. Windows 10 (home 
use) 

Multi-user OS Many users at the same time (on 
different systems). 

Linux, UNIX 
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Mobile OS Designed for smartphones and tablets. Android, iOS 

 

💻 Popular Operating Systems: 

●​ Microsoft Windows – Most commonly used on desktops and laptops​
 

●​ macOS – Used in Apple Mac computers​
 

●​ Linux – Free and open-source; used by programmers and servers​
 

●​ Android – Used in most smartphones​
 

●​ iOS – Used in Apple iPhones and iPads​
 

 

📦 Example Scenario: 

When you press the power button: 

1.​ The OS starts first.​
 

2.​ It shows the desktop.​
 

3.​ You open a program like MS Word.​
 

4.​ The OS loads the program and allows you to type.​
 

5.​ You click save, and the OS stores the file in memory.​
 

Without the OS, none of these things would happen! 

 

🔹 5.2 Functions of an Operating System (OS) 

The Operating System (OS) is the most important software in a computer. It performs many 
functions to keep the computer running smoothly and help users interact with the system. 

 

77 

http://thetmnotes.com


Th
eT
mN
ote
s.c
om

Introduction to Information & Communication Technologies (ICT) By TheTmNotes.com 
 

 
✅ 1. Starting and Shutting Down a Computer 

●​ When you press the power button, the OS loads automatically.​
 

●​ This process is called booting.​
 

●​ When you shut down the computer, the OS safely closes all programs and turns off 
the system.​
 

🧠 Example: Windows shows the logo and desktop when it starts. When you click "Shut Down," 
it closes files and powers off the computer. 

 

✅ 2. Providing a User Interface 

●​ The OS gives you a way to interact with the computer.​
 

●​ Most modern OS use Graphical User Interface (GUI) with icons, buttons, and windows.​
 

●​ Some OS also use Command Line Interface (CLI) where you type commands.​
 

🧠 Example: Clicking folders and files on your desktop is using the GUI. 

 

 

 

✅ 3. Managing Programs 

●​ The OS runs and closes software programs.​
 

●​ It also helps in switching between programs.​
 

🧠 Example: You can use MS Word and Google Chrome at the same time. 

 

✅ 4. Managing Memory 
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●​ RAM is limited. The OS decides how much memory (RAM) each program needs.​

 
●​ It also frees up memory when programs are closed.​

 

🧠 Example: If too many programs are open, the OS might slow down because RAM is full. 

 

✅ 5. Coordinating Tasks 

●​ The OS handles multitasking by making sure all tasks get processor time.​
 

●​ It organizes how the CPU handles many instructions at once.​
 

🧠 Example: Listening to music while typing a document. 

 

✅ 6. Configuring Devices 

●​ The OS helps the computer work with hardware devices like printers, keyboards, 
mouse, webcams, etc.​
 

●​ It uses drivers to make the hardware work correctly.​
 

🧠 Example: When you connect a printer, the OS installs or uses a printer driver. 

 

 

 

 

✅ 7. Establishing an Internet Connection 

●​ The OS helps you connect to the internet through Wi-Fi, Ethernet, or mobile data.​
 

●​ It manages the settings and drivers needed for the connection.​
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🧠 Example: The "Network Settings" in Windows allow you to connect to Wi-Fi. 

 

✅ 8. Monitoring Performance 

●​ The OS checks how well the computer is working.​
 

●​ It shows CPU usage, RAM usage, and running programs.​
 

🧠 Example: Task Manager in Windows shows which apps are using the most memory or CPU. 

 

✅ 9. Providing File Management and Other Utilities 

●​ The OS helps you create, open, move, copy, rename, and delete files.​
 

●​ It includes utility programs like Disk Cleanup, File Explorer, and antivirus tools.​
 

🧠 Example: You organize your documents in folders using File Explorer. 

 

✅ 10. Updating Software Automatically 

●​ The OS checks for updates and installs them automatically to improve performance and 
security.​
 

🧠 Example: Windows Update installs new features and bug fixes without user input. 

 

✅ 11. Controlling a Network 

●​ In a network environment (like a school or office), the OS controls how computers share 
files, printers, and internet.​
 

●​ Some OS, like Windows Server or Linux, are designed for network management.​
 

🧠 Example: Multiple computers in a lab can be connected through one central server. 
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✅ 12. Administering Security 

●​ The OS provides security features to protect your files and data.​
 

●​ It includes password protection, user accounts, firewalls, and antivirus support.​
 

🧠 Example: You log in to your computer with a password, and the OS blocks viruses using 
Windows Defender. 

 

 

🔹 5.3 Types of Operating Systems 

An Operating System (OS) can be used for different types of computers based on their size, 
purpose, and user needs. In this section, we will learn about three main types of operating 
systems and some popular examples. 

 

✅ 1. Stand-Alone Operating System 

A stand-alone OS is used on personal computers like desktops and laptops. It can work 
independently and does not need a network to function. 

📌 Features: 

●​ Controls all hardware and software on a single computer​
 

●​ User-friendly (has desktop, icons, menus)​
 

●​ Allows multitasking​
 

●​ Common in homes, offices, and schools​
 

🧠 Examples: 

●​ Microsoft Windows (Windows 10, Windows 11)​
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●​ Linux (Ubuntu, Mint)​

 
●​ macOS (for Apple computers)​

 

 

✅ 2. Server Operating System 

A server OS is used in network servers. It manages many computers (clients) at the same 
time. These OS are powerful and are used in businesses, schools, colleges, and data 
centers. 

📌 Features: 

●​ Handles multiple users and devices​
 

●​ Controls file sharing, printers, databases, and internet access​
 

●​ Provides high security​
 

●​ Needs expert knowledge to use​
 

🧠 Examples: 

●​ Windows Server​
 

●​ Linux Server​
 

●​ UNIX​
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✅ 3. Embedded Operating System 

An embedded OS is installed in special small devices that are not traditional computers. 
These devices perform specific tasks only. 

📌 Features: 

●​ Very small and fast​
 

●​ Limited features​
 

●​ Cannot install new programs​
 

●​ Used in machines and electronics​
 

🧠 Examples: 

●​ Smart TVs​
 

●​ ATMs​
 

●​ Washing machines​
 

●​ GPS devices​
 

●​ Digital cameras​
 

 

🔷 Common Operating Systems (Examples) 

✅ Microsoft Windows: 

●​ Most popular OS for desktops and laptops​
 

●​ Easy to use with GUI (Graphical User Interface)​
 

●​ Examples: Windows 10, Windows 11​
 

✅ Linux: 
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●​ Open-source (free to use and modify)​

 
●​ Very secure and used in servers and personal computers​

 
●​ Many types (called “distros”) like Ubuntu, Debian, Mint​

 

 
 
 
 

📌 Summary Table: 

OS Type Used In Features Examples 

Stand-Alone 
OS 

PCs, Laptops Multitasking, GUI, runs without 
network 

Windows, Linux, 
macOS 

Server OS Network Servers Multi-user support, file & 
network sharing 

Windows Server, 
UNIX 

Embedded 
OS 

Devices like ATMs, 
Cameras 

Fast, limited functions, not 
customizable 

Android TV, ATM 
OS 

 
 

🔹 5.4 OS Utility Programs 

💡 What are Utility Programs? 

Utility Programs are small software tools that help the Operating System (OS) maintain and 
improve the performance of a computer. These tools help with cleaning, protecting, 
organizing, and fixing different parts of the system. 

 

✅ Common Utility Programs: 
 

1. File Manager 

Helps users view, open, rename, copy, move, and delete files and folders.​
 🧠 Example: Windows File Explorer. 

84 

http://thetmnotes.com


Th
eT
mN
ote
s.c
om

Introduction to Information & Communication Technologies (ICT) By TheTmNotes.com 
 

 
 

2. Search Utility 

Helps you find files and folders quickly by typing names or keywords.​
 🧠 Example: Windows Search bar. 

 
 
 
 
 

3. Uninstaller 

Used to remove or uninstall software programs from your computer.​
 🧠 Example: Control Panel > Programs > Uninstall a Program. 

 

4. Image Viewer 

Lets you open and view pictures (JPG, PNG, etc.) without editing them.​
 🧠 Example: Windows Photo Viewer. 

 

5. Disk Cleanup 

Removes unwanted files, like temporary files and system cache, to free up space.​
 🧠 Example: Windows Disk Cleanup tool. 

 

6. Disk Defragmenter 

Rearranges data on the hard disk so the system can access it faster.​
 This improves speed and performance of older hard drives.​
 🧠 Example: Defragment and Optimize Drives in Windows. 

 

7. Backup and Restore Utilities 
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Used to save copies of your important files or system and restore them in case of a system 
crash or virus.​
 🧠 Example: Windows Backup and Restore. 

 

8. Screen Saver 

A program that runs when the computer is idle.​
 It prevents screen burn on older monitors and can be used for fun or security.​
 🧠 Example: Floating text or slideshow when no keys are pressed. 

 
 
 

9. Firewall 

Protects your computer from unauthorized access from the internet or network.​
 Acts like a gatekeeper for incoming and outgoing data.​
 🧠 Example: Windows Defender Firewall. 

 

10. Antivirus Programs 

Protects your computer from viruses, malware, and harmful software.​
 It scans your files and alerts you if something is unsafe.​
 🧠 Example: Avast, Windows Defender, Norton. 

 

11. Spyware and Adware Removers 

Special tools to remove spyware (that steals data) and adware (that shows unwanted ads) 
from your computer.​
 🧠 Example: Malwarebytes, AdwCleaner. 

 

12. File Compression Tools 

These tools reduce the file size by compressing data.​
 Used to save space and share large files easily.​
 🧠 Example: WinRAR, 7-Zip, Windows built-in ZIP tool. 
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13. Media Player 

Used to play audio and video files like MP3, MP4, etc.​
 🧠 Example: Windows Media Player, VLC Media Player. 

 

14. Disc Burning Utility 

Helps you burn (write) data, music, or videos to CDs, DVDs, or Blu-ray discs.​
 🧠 Example: Nero, Windows Disc Burner. 

 
 

📌 Summary Table: 

Utility Name Purpose 

File Manager Manage files and folders 

Search Utility Find files quickly 

Uninstaller Remove software 

Image Viewer View pictures 

Disk Cleanup Free up space by deleting junk files 

Disk Defragmenter Speed up system by organizing disk 
data 

Backup & Restore Save and recover data 

Screen Saver Activate display visuals during inactivity 

Firewall Block unauthorized internet access 

Antivirus Remove viruses and malware 

Spyware Remover Remove hidden spying software 

File Compression Reduce file size for saving/sharing 

Media Player Play music and videos 
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Disc Burning Write files to CD/DVD 

 

🔹 5.5 Personal Computer Maintenance 

A personal computer (PC) is a valuable machine that helps us in learning, working, and 
staying connected. Just like we take care of our bodies or vehicles, a computer also needs 
regular care and maintenance to keep it running fast, safe, and error-free. 

 
 
 
 
 
 
 

✅ Why is PC Maintenance Important? 

●​ Increases the speed of the computer​
 

●​ Prevents errors and crashes​
 

●​ Protects against viruses and threats​
 

●​ Increases the lifespan of the computer​
 

●​ Keeps your data safe and organized​
 

 

✅ Common Personal Computer Maintenance Tips 
 

1. Keep Your PC Clean 

●​ Use a soft cloth to clean the monitor, keyboard, and mouse.​
 

●​ Use a blower or air spray to remove dust from the CPU and fans.​
 

●​ Keep your PC in a dust-free environment.​
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🧠 Reason: Dust can block air and cause the system to overheat. 

 

2. Run Antivirus Software 

●​ Always install a trusted antivirus.​
 

●​ Keep it updated.​
 

●​ Scan your computer regularly for viruses and malware.​
 

🧠 Reason: Viruses can damage files, steal data, or slow down your PC. 

 

3. Use Disk Cleanup 

●​ Use built-in tools like Disk Cleanup to remove junk files.​
 

●​ It clears temporary files, recycle bin, and cache.​
 

🧠 Reason: It helps to free up disk space and improve performance. 

 

4. Defragment the Hard Drive 

●​ Use Disk Defragmenter to organize scattered files on the hard drive (only for HDD, not 
SSD).​
 

🧠 Reason: Helps your computer read data faster. 

 

5. Update Software and Windows 

●​ Keep your Windows OS and software updated.​
 

●​ Updates fix bugs, add new features, and improve security.​
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🧠 Reason: Prevents security threats and keeps the system running smoothly. 

 

6. Uninstall Unused Programs 

●​ Remove programs you don’t use anymore from Control Panel.​
 

🧠 Reason: Saves space and reduces load on the system. 

 

7. Backup Your Data 

●​ Always keep a copy of your important files on an external hard drive or cloud storage.​
 

🧠 Reason: In case your system crashes, your data stays safe. 

 

8. Avoid Overloading the System 

●​ Don’t open too many programs at once.​
 

●​ Close tabs and software that are not in use.​
 

🧠 Reason: Prevents system slowdowns and crashes. 

 

9. Protect from Power Problems 

●​ Use a UPS (Uninterruptible Power Supply) to protect your PC from sudden power cuts 
and voltage issues.​
 

🧠 Reason: Sudden shutdowns can damage hardware or corrupt files. 

 

10. Keep Your PC in a Safe Place 
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●​ Place your PC in a cool, dry, and safe area.​

 
●​ Avoid placing liquids or food near your PC.​

 

🧠 Reason: Prevents accidental damage or short circuits. 

 
 
 

📌 Summary Table 

Maintenance Tip Benefit 

Keep PC clean Prevents overheating and damage 

Use antivirus Protects against malware and 
viruses 

Run disk cleanup Frees up space 

Defragment disk Speeds up file access 

Update OS/software Fixes bugs and adds security 

Uninstall unused software Reduces system load 

Backup data Prevents data loss 

Avoid system overload Improves speed and stability 

Use a UPS Protects from power issues 

Safe placement Reduces risk of accidents 

 
 
 
 
 
 
 
 

📘 Chapter 6: Application Software 

91 

http://thetmnotes.com


Th
eT
mN
ote
s.c
om

Introduction to Information & Communication Technologies (ICT) By TheTmNotes.com 
 

 
🔹 6.1 The Need and Role of Application Software 

 

💡 What is Application Software? 

Application Software is a type of computer program that is designed to do a specific task for 
the user. These tasks can be related to writing, drawing, calculating, editing videos, browsing 
the internet, or even playing games. 

Application software runs on top of the operating system and helps users do their everyday 
work. 

 

✅ Why Do We Need Application Software? 

The main purpose of a computer is to help us perform useful work. Without application 
software, we can’t: 

●​ Type letters or documents​
 

●​ Make calculations​
 

●​ Create designs or drawings​
 

●​ Watch videos or listen to music​
 

●​ Use the internet​
 

In short, we need application software to make the computer useful for real-world tasks. 

 

 

 

 

🎯 Role of Application Software in Our Daily Life 

Task Application Software Example 
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Writing letters Microsoft Word 

Making calculations Microsoft Excel, Calculator 

Creating presentations Microsoft PowerPoint 

Browsing the internet Google Chrome, Mozilla Firefox 

Watching videos VLC Media Player, Windows Media Player 

Drawing and design Adobe Photoshop, CorelDRAW 

Managing email Microsoft Outlook, Gmail 

Making databases Microsoft Access 

Learning and practicing Educational apps or typing tutors 

Communication Zoom, WhatsApp Web, Skype 

 

🧠 Categories of Application Software: 

1.​ Productivity Software​
 Helps you work efficiently.​
 Example: MS Word, Excel, PowerPoint​
 

2.​ Multimedia Software​
 Used for playing or editing videos, music, and images.​
 Example: VLC Media Player, Photoshop​
 

3.​ Web Browsers​
 Used to access websites and information online.​
 Example: Chrome, Firefox​
 

4.​ Educational Software​
 Helps in learning and teaching.​
 Example: Typing Tutor, Khan Academy App​
 

5.​ Communication Software​
 Used to send messages or video chat.​
 Example: Zoom, Skype, Gmail​
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6.​ Gaming Software​

 For entertainment and games.​
 Example: PUBG, Candy Crush, Chess 

 

🔹 6.2 Working with Application Software 
Once installed, application software can be opened and used like any other tool. Here's how 
students and users typically work with application software: 

 

✅ 1. Opening the Software 

You can open a program by: 

●​ Clicking on its icon on the desktop or start menu​
 

●​ Searching its name in the search bar​
 

🧠 Example: To open MS Word, click its icon or type “Word” in the search. 

 

✅ 2. Using Menus and Tools 

Most software has a menu bar and toolbar with different options like: 

●​ File (to open/save files)​
 

●​ Edit (to cut, copy, paste)​
 

●​ Insert (to add images, tables, etc.)​
 

🧠 Example: In MS Word, you use the "Insert" tab to add pictures into your document. 
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✅ 3. Creating and Saving Files 

●​ You can create new files (like documents or presentations).​
 

●​ Use Save or Save As to keep a copy of your work on the computer or USB.​
 

🧠 Example: Save your assignment in MS Word by clicking “File > Save”. 

 

✅ 4. Editing and Formatting 

You can: 

●​ Change font style, size, and color​
 

●​ Add bold, italic, underline​
 

●​ Insert pictures, shapes, and tables​
 

🧠 Example: In Excel, you can highlight important numbers using color and bold fonts. 

 

✅ 5. Printing Documents 

Most software allows you to print your files using the Print option in the File menu. 

🧠 Example: Print your notes from MS Word using File > Print. 

 

✅ 6. Closing the Software 

When done, click on the "X" button or choose File > Exit to close the application. 

 

📝 Tips for Working Safely with Application Software: 
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●​ Save your work regularly to avoid data loss.​

 
●​ Do not download unknown software from the internet.​

 
●​ Use genuine and updated software for best performance and security.​

 

 

📌 Summary: 

●​ Application software is easy to use with buttons, icons, and menus.​
 

●​ It helps in creating, editing, saving, and printing different kinds of files.​
 

●​ Every user, whether a student or professional, needs to learn how to use application 
software effectively.​
 

🔹 6.3 Business Software 

Business software is used by offices, companies, and professionals to manage their daily 
work. It helps in creating documents, handling money, managing tasks, storing records, 
designing graphics, and much more. 

Let’s understand each type of business software in simple terms: 

 

✅ 1. Word Processing Software 

Used to write, edit, and format text documents. 

🧠 Examples: Microsoft Word, Google Docs 

📝 Used for: 

●​ Writing letters​
 

●​ Making reports​
 

●​ Designing CVs​
 

●​ Printing office notices​
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✅ 2. Spreadsheets 

Used to organize data in rows and columns, and do calculations using formulas. 

🧠 Examples: Microsoft Excel, Google Sheets 

📝 Used for: 

●​ Budget planning​
 

●​ Marks sheets​
 

●​ Salary records​
 

●​ Business calculations​
 

 

✅ 3. Databases 

Used to store and manage large amounts of information in an organized way. 

🧠 Examples: Microsoft Access, Oracle, MySQL 

📝 Used for: 

●​ Managing customer records​
 

●​ Keeping employee information​
 

●​ Tracking sales and products​
 

 

✅ 4. Presentation Software 

Used to create slideshows to present information with text, images, and animations. 

🧠 Examples: Microsoft PowerPoint, Google Slides 
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📝 Used for: 

●​ Business meetings​
 

●​ Class lectures​
 

●​ Product presentations​
 

 

✅ 5. Project Management Software 

Helps in planning, scheduling, and tracking progress of business projects. 

🧠 Examples: Microsoft Project, Trello, Asana 

📝 Used for: 

●​ Assigning tasks​
 

●​ Managing deadlines​
 

●​ Monitoring work progress​
 

 

✅ 6. Personal Information Manager (PIM) Software 

Keeps track of personal tasks, appointments, and contacts. 

🧠 Examples: Microsoft Outlook, Google Calendar 

📝 Used for: 

●​ Managing meetings​
 

●​ Storing email addresses​
 

●​ Keeping to-do lists​
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✅ 7. Business Software for Smartphones 

Mobile apps that help manage business activities anytime, anywhere. 

🧠 Examples: Google Sheets (mobile), WhatsApp Business, QuickBooks Mobile 

📝 Used for: 

●​ Managing documents​
 

●​ Communicating with clients​
 

●​ Tracking money on the go​
 

 

✅ 8. Accounting Software 

Used to manage financial records like income, expenses, profit, and tax. 

🧠 Examples: QuickBooks, Peachtree, Wave 

📝 Used for: 

●​ Making invoices​
 

●​ Calculating salaries​
 

●​ Generating reports​
 

 

🎨 Graphics & Multimedia Software 
Used for designing, drawing, editing images and videos, and creating websites or 
multimedia content. 

 

✅ 9. Computer-Aided Design (CAD) 

Used to create 2D and 3D designs for engineering, architecture, and manufacturing. 
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🧠 Examples: AutoCAD, SolidWorks 

📝 Used for: 

●​ Designing buildings, machines, cars​
 

 

✅ 10. Desktop Publishing Software 

Used to design and print books, newspapers, magazines, brochures. 

🧠 Examples: Adobe InDesign, Microsoft Publisher 

📝 Used for: 

●​ Creating flyers​
 

●​ Designing certificates​
 

●​ Making book layouts​
 

 

✅ 11. Paint / Image Editing Software 

Used to draw pictures or edit photos. 

🧠 Examples: Adobe Photoshop, MS Paint, GIMP 

📝 Used for: 

●​ Editing photos​
 

●​ Creating banners​
 

●​ Designing logos​
 

 

✅ 12. Video and Audio Editing Software 

Used to edit, cut, and mix videos and sounds. 
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🧠 Examples: Adobe Premiere Pro, Audacity, Camtasia 

📝 Used for: 

●​ Making YouTube videos​
 

●​ Editing short films or lectures​
 

●​ Adding sound effects to videos​
 

 

✅ 13. Multimedia Authoring Software 

Used to create interactive multimedia projects like e-learning courses or presentations with 
audio, video, and quizzes. 

🧠 Examples: Adobe Flash, Adobe Captivate 

📝 Used for: 

●​ Creating educational content​
 

●​ Making interactive CD/DVD content​
 

 

✅ 14. Web Page Authoring Software 

Used to create and design websites. 

🧠 Examples: Adobe Dreamweaver, WordPress 

📝 Used for: 

●​ Making company websites​
 

●​ Designing blogs or eCommerce pages​
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📌 Summary Table 

Category Examples Main Use 

Word 
Processing 

MS Word Typing documents 

Spreadsheet MS Excel Data and calculations 

Database MS Access Storing and managing 
records 

Presentations PowerPoint Creating slideshows 

Project 
Management 

Trello, MS Project Planning and tracking 
tasks 

PIM Software Outlook Managing 
appointments 

Mobile 
Business Apps 

QuickBooks, 
Sheets 

Business tasks on 
smartphone 

Accounting QuickBooks Managing money 
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CAD AutoCAD Engineering and 
design work 

Desktop 
Publishing 

InDesign, 
Publisher 

Designing printed 
material 

Image Editing Photoshop, Paint Photo and image 
editing 

Video/Audio 
Editing 

Camtasia, 
Audacity 

Editing videos and 
sound 

Multimedia 
Authoring 

Captivate Creating e-learning 
tools 

Web Page 
Authoring 

Dreamweaver, 
WordPress 

Website development 

 

🔹 6.4 Web Applications 

💡 What is a Web Application? 

A web application is a type of software that you can use directly from a web browser (like 
Google Chrome or Firefox). You don’t need to install it on your computer. It runs on the 
internet. 

 

✅ Features of Web Applications: 

●​ Can be used on any device with internet​
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●​ Easy to access using a web browser​

 
●​ No installation needed​

 
●​ Data is usually stored online (in the cloud)​

 

 

🧠 Examples of Web Applications: 

Task Web Application Example 

Writing documents Google Docs 

Creating 
spreadsheets 

Google Sheets 

Making presentations Google Slides 

Checking email Gmail, Yahoo Mail 

Watching videos YouTube 

Video meetings Zoom Web, Google Meet 

Online banking Bank websites 

Learning and quizzes Kahoot, Google Classroom, Quizizz 
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📌 Benefits of Web Applications: 

●​ Use from anywhere (home, school, office)​
 

●​ Save files online (can’t lose them easily)​
 

●​ Easy to share files with others​
 

●​ Always up to date​
 

 

✅ Conclusion: 

Web applications are helpful tools that work with the internet. Students, teachers, and office 
workers use them every day to write, study, present, and communicate online. 

 

🔹 6.5 Typing Assistance Software (Typing Tutor / Master) 

💡 What is Typing Assistance Software? 

Typing assistance software helps users learn and improve their typing skills. These 
programs show which keys to press and measure your speed and accuracy. 

 

✅ Features of Typing Tutors: 

●​ Practice typing with lessons and games​
 

●​ Track your typing speed (in words per minute)​
 

●​ Show your mistakes so you can improve​
 

●​ Teach finger positions for correct typing​
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🧠 Examples of Typing Software: 

Software Name Description 

Typing Master Popular offline typing trainer 

Rapid Typing Tutor Colorful lessons and games 

KeyBlaze Beginner to advanced level 
lessons 

TypingClub (Web App) Online typing practice tool 

Ratatype Online with typing certificates 

 

📌 Benefits of Using Typing Software: 

●​ Helps students type fast and accurately​
 

●​ Improves computer skills​
 

●​ Saves time in writing documents and exams​
 

●​ Prepares for office work where typing is needed​
 

 

✅ Conclusion: 
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Typing software is very important for students and professionals. Good typing speed saves time 
and boosts productivity. Every DIT student should practice typing daily to become confident 
and fast on the keyboard. 

📘 Chapter 7: The Internet and the World Wide Web 

🔹 7.1 Network and the Internet 
 

💡 What is a Network? 

A network is a group of two or more computers that are connected together so they can 
share data, files, and resources like printers and internet. 

🧠 Example: 

●​ Computers in your school connected to one printer form a network.​
 

●​ Wi-Fi at home connects mobiles, laptops, and smart TVs — this is a home network.​
 

 

💡 What is the Internet? 

The Internet is the world’s largest network. It is a global system of millions of computers and 
devices connected together. It allows people to: 

●​ Send emails​
 

●​ Browse websites​
 

●​ Watch videos​
 

●​ Use social media​
 

●​ Do online shopping​
 

🧠 Easy words: The Internet connects people around the world through their computers and 
phones. 

 

107 

http://thetmnotes.com


Th
eT
mN
ote
s.c
om

Introduction to Information & Communication Technologies (ICT) By TheTmNotes.com 
 

 

🌐 Connecting to the Internet 
To use the internet, you need: 

1.​ A Device – Computer, mobile, tablet​
 

2.​ Internet Connection – Wi-Fi or mobile data​
 

3.​ Internet Service Provider (ISP) – A company that gives you internet access​
 

 

✅ Internet Access Methods: 

Method Description 

DSL Uses telephone lines, slower than fiber 

Fiber-Optic Very fast, uses light signals 

Mobile Data (3G/4G/5G) Internet on phones through SIM cards 

Wi-Fi Wireless internet at home, office, 
cafes 

Satellite Used in remote areas, slower than 
fiber 

 

🧑‍💻 Access Providers (ISPs) 
An Internet Service Provider (ISP) is a company that gives users access to the internet. 

🧠 Examples in Pakistan: 

●​ PTCL​
 

●​ StormFiber​
 

●​ Nayatel​
 

●​ Zong, Jazz, Telenor (for mobile internet)​
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💡 How they work: 

●​ You pay them monthly​
 

●​ They give you a modem or SIM​
 

●​ You connect and start using internet​
 

 

📦 How Data Travels on the Internet 
When you send a message, open a website, or watch a video: 

1.​ Your computer breaks data into small pieces called packets.​
 

2.​ Packets travel through cables, satellites, or mobile towers.​
 

3.​ These packets are sent to other computers or websites.​
 

4.​ When they reach the destination, they are reassembled.​
 

🧠 Simple Example:​
 Sending a file is like sending a parcel in many small boxes, which get delivered and then 
opened together. 

 

🧭 Internet Addresses 
Every device and website on the internet has a unique address to find it. 

✅ Types of Internet Addresses: 

1.​ IP Address​
 

○​ A number that identifies a computer on the internet​
 

○​ Example: 192.168.1.1​
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2.​ Domain Name​

 
○​ A readable website name (easier than numbers)​

 
○​ Example: www.google.com​

 
○​ Domains end in .com, .pk, .edu, .gov etc.​

 
3.​ URL (Uniform Resource Locator)​

 
○​ Full web address you type in the browser​

 
○​ Example: https://www.facebook.com 

🔹 7.2 The World Wide Web 
 

🌍 What is the World Wide Web (WWW)? 

The World Wide Web (WWW) is a part of the internet. It is a collection of websites and web 
pages that you can view using a web browser. 

💡 Remember: The internet is the network, and the Web is the content (pages, images, 
videos, etc.) available on that network. 

🧠 Example: When you open Google, YouTube, or Wikipedia — you are using the World Wide 
Web. 

 

🌐 Browsing the Web 
To browse (surf) the web, you use a web browser. A browser is software that shows web 
pages. 

✅ Common Web Browsers: 

●​ Google Chrome​
 

●​ Mozilla Firefox​
 

●​ Microsoft Edge​
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●​ Safari​

 
●​ Opera​

 

🔸 Steps to Browse: 

1.​ Open your browser​
 

2.​ Type a web address (like www.google.com)​
 

3.​ Press Enter​
 

4.​ The browser shows the web page​
 

 

📮 Web Addresses 
Each web page has a unique web address called a URL (Uniform Resource Locator). It tells 
the browser where to find the web page. 

✅ Example of a Web Address: 
arduino 
CopyEdit 
https://www.wikipedia.org 
 

🔍 Parts of a Web Address: 

●​ https:// — Secure connection​
 

●​ www — World Wide Web​
 

●​ wikipedia — Website name​
 

●​ .org — Domain type (others are .com, .pk, .edu, .gov, etc.)​
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🧭 Navigating Web Pages 
When you're on a web page, you can: 

●​ Click links to open other pages​
 

●​ Use the Back and Forward buttons​
 

●​ Use the Home button to go back to your homepage​
 

●​ Scroll up and down to read all content​
 

●​ Fill out forms, watch videos, or download files​
 

🧠 Example: On a shopping site, click a product to see more details. 

 

🔎 Searching on the Web 
To find information, use a search engine like: 

●​ Google​
 

●​ Bing​
 

●​ Yahoo​
 

●​ DuckDuckGo​
 

🔸 How to Search: 

1.​ Open your browser​
 

2.​ Go to a search engine (e.g., www.google.com)​
 

3.​ Type your question or keywords​
 

4.​ Press Enter​
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5.​ Click on any useful link from the results​

 

🧠 Example: Type “weather in Lahore” to see the latest weather. 

 

🖥️ Types of Web Sites 
Websites are made for different purposes. Common types include: 

Type of 
Website 

Description Example 

News Shows latest news and updates www.bbc.com 

Educational Offers learning material www.khanacademy.org 

Entertainment Music, movies, games www.youtube.com 

E-commerce Online shopping www.daraz.pk 

Government Official services and info www.pmo.gov.pk 

Social Media Connects people and shares 
posts 

www.facebook.com 

Blogs Personal opinions or info articles www.medium.com 

Search Engines Help find web content www.google.com 

 

🌐 Web Publishing 
Web publishing means creating and uploading your own website on the internet so others 
can visit it. 

✅ Steps in Web Publishing: 

1.​ Create content (text, pictures, videos)​
 

2.​ Design your web pages using software like WordPress, Wix, or HTML/CSS​
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3.​ Buy a domain name (like www.mywebsite.com)​

 
4.​ Get web hosting (a place to store your website online)​

 
5.​ Upload your website using a control panel or FTP​

 
6.​ Now, anyone can visit your site from anywhere!​

 

🧠 Example: A school can create a website to show student results, news, and events. 

 

📌 Summary Table: 
Term Meaning 

World Wide Web Collection of websites on the internet 

Browser Software used to open web pages 

URL Web address of a page 

Search Engine Tool to find information online 

Website Types News, education, shopping, etc. 

Web Publishing Making your own website 

 
 
 

🔹 7.3 E-Commerce 

💡 What is E-Commerce? 

E-Commerce stands for Electronic Commerce. It means buying and selling things using 
the Internet. This can be done through websites or mobile apps. 

🧠 Simple example: When you buy clothes, books, or a mobile phone from a website like Daraz 
or Amazon, you are using e-commerce. 
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✅ Types of E-Commerce: 

Type Description Example 

B2C (Business to Customer) A business sells to the public Daraz.pk, OLX 

B2B (Business to Business) A business sells to another 
business 

Alibaba.com 

C2C (Customer to Customer) People sell to other people Facebook 
Marketplace 

C2B (Customer to Business) People offer services to companies Freelancers on Fiverr 

 

✅ Features of E-Commerce: 

●​ Available 24/7 (any time, any day)​
 

●​ You can shop from anywhere​
 

●​ Home delivery of products​
 

●​ Easy payment methods (Cash on Delivery, Debit/Credit card, JazzCash etc.)​
 

 

✅ Benefits of E-Commerce: 

●​ Saves time and travel​
 

●​ More choices and better prices​
 

●​ Makes business easier and faster​
 

●​ Helps small businesses reach more people​
 

 

🔹 7.4 Other Services on the Internet 
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The internet offers many more useful services besides browsing websites and shopping. Here 
are some important ones: 

 

📧 1. E-Mail (Electronic Mail) 

Used to send and receive messages, documents, or pictures through the internet. 

🧠 Examples: Gmail, Yahoo Mail, Outlook 

📝 Features: 

●​ Write and send messages quickly​
 

●​ Attach files like documents or images​
 

●​ Create contact lists​
 

●​ Organize inbox with folders​
 

 

💬 2. Instant Messaging 

Used to chat with people in real time (live), using text or emojis. 

🧠 Examples: WhatsApp, Facebook Messenger, Telegram 

📝 Features: 

●​ Send quick messages​
 

●​ Share photos and videos​
 

●​ Group chats and voice notes​
 

 

📞 3. VoIP (Voice over Internet Protocol) 

Lets you make voice and video calls using the internet instead of a mobile network. 
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🧠 Examples: Skype, WhatsApp Calls, Zoom, Google Meet 

📝 Benefits: 

●​ Low-cost or free calls​
 

●​ Good for international calling​
 

●​ Supports video conferencing​
 

 

📁 4. FTP (File Transfer Protocol) 

A method to upload or download large files between computers over the internet. 

🧠 Used for: 

●​ Website file uploading​
 

●​ Sharing software updates​
 

●​ Backing up data on servers​
 

🧠 Example software: FileZilla 

 

🎥 5. Video Conferencing 

Used to meet online with video and audio, especially for schools, colleges, and offices. 

🧠 Examples: Zoom, Google Meet, Microsoft Teams 

📝 Used for: 

●​ Online classes​
 

●​ Business meetings​
 

●​ Virtual events​
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🌐 6. Social Media 

Websites and apps used to connect with friends, share posts, photos, and videos. 

🧠 Examples: Facebook, Instagram, Twitter, TikTok 

📝 Benefits: 

●​ Stay connected​
 

●​ Follow news and trends​
 

●​ Share your ideas and experiences​
 

●​ Good for marketing and business promotion​
 

 

📌 Summary Table 
Service Purpose Example 

E-Mail Send and receive messages Gmail, Outlook 

Instant Messaging Live text chats WhatsApp, 
Messenger 

VoIP Internet voice and video calls Skype, Zoom 

FTP File transfer between computers FileZilla 

Video 
Conferencing 

Online meetings with audio/video Zoom, Google Meet 

Social Media Share and connect with others 
online 

Facebook, Instagram 

 

🔹 7.5 Computer Security 

Topics Covered: 

●​ What is Computer Security?​
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●​ Common Types of Malware: Virus, Worm, Trojan Horse​

 
●​ Attacks on Computers​

 
●​ Safeguards and Protection Methods​

 

 

🛡️ What is Computer Security? 
Computer security means protecting your computer and data from harmful programs (called 
malware) and unauthorized access. 

Just like you lock your home to keep it safe, you need to protect your computer to stop 
hackers and viruses from damaging your files. 

 

🦠 What is Malware? 
Malware means “malicious software” — bad programs that can harm your computer or 
steal your information. 

There are many types of malware. Let’s understand the common ones: 

 

✅ 1. Virus 

●​ A virus is a program that attaches itself to other files or software.​
 

●​ It spreads from one computer to another through USB, email, or downloads.​
 

●​ It can delete files, slow down your system, or crash it.​
 

🧠 Example: A virus that hides your files on USB or changes your documents. 

 

✅ 2. Worm 
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●​ A worm spreads by itself across networks or the internet.​

 
●​ It doesn’t need a file to attach to.​

 
●​ It can cause networks to slow down or crash by using up all resources.​

 

🧠 Example: A worm that keeps multiplying and fills up all your storage space. 

 

✅ 3. Trojan Horse 

●​ A Trojan horse looks like a useful program, but it is harmful.​
 

●​ Once opened, it may steal personal data, track your activity, or give control to 
hackers.​
 

🧠 Example: A fake game or software that secretly spies on your data. 

 

✅ 4. Other Attacks 

Attack Type Description 

Spyware Watches your activity without permission 

Adware Shows unwanted ads or pop-ups 

Ransomwar
e 

Locks your data and demands payment 

Phishing Fake emails or websites that steal info 

Hacking Unauthorized access to your computer 

 

🔐 Safeguards Against Malware 
To keep your computer safe, follow these best practices: 

 

120 

http://thetmnotes.com


Th
eT
mN
ote
s.c
om

Introduction to Information & Communication Technologies (ICT) By TheTmNotes.com 
 

 
✅ 1. Install Antivirus Software 

●​ Scans for and removes viruses​
 

●​ Works in the background for protection​
 

🧠 Examples: Avast, Bitdefender, Windows Defender 

 

✅ 2. Keep Software Updated 

●​ Always install Windows and software updates​
 

●​ Updates fix security holes​
 

 

✅ 3. Avoid Suspicious Links and Downloads 

●​ Don’t click on unknown email links​
 

●​ Download software only from trusted websites​
 

 

✅ 4. Use Strong Passwords 

●​ Use long passwords with letters, numbers, and symbols​
 

●​ Change passwords regularly​
 

 

✅ 5. Backup Your Data 

●​ Keep a copy of your files on a USB, external hard drive, or cloud​
 

●​ Helps in case of virus attack or system crash​
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✅ 6. Enable Firewalls 

●​ A firewall blocks unwanted traffic from reaching your computer​
 

●​ It’s usually built-in with antivirus or Windows​
 

 

📌 Summary Table 

Term Meaning 

Virus Spreads by attaching to files 

Worm Spreads automatically through 
networks 

Trojan Horse Looks safe but is harmful 

Spyware Watches your activity silently 

Antivirus Software to detect and remove threats 

Firewall Protects against unauthorized access 

Backup Extra copy of important data 

 
 

🔹 7.6 Information Privacy 

💡 What is Information Privacy? 

Information privacy means keeping your personal data safe when using computers or the 
internet. 

🧠 Example: Your name, address, phone number, passwords, and pictures are private. If 
someone uses them without your permission, your privacy is stolen. 

 

✅ How Privacy Can Be Leaked: 
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●​ Filling forms on unsafe websites​

 
●​ Clicking on fake links or emails​

 
●​ Sharing personal info on social media​

 
●​ Not using strong passwords​

 

 

✅ How to Protect Your Privacy: 

●​ Use strong passwords and don’t share them​
 

●​ Don’t post personal info on public sites​
 

●​ Use secure websites (look for “https://”)​
 

●​ Keep social media accounts private​
 

 

🔹 7.7 Computer Ethics 

💡 What are Computer Ethics? 

Computer ethics means using computers in a right and respectful way. It is about knowing 
what is right and wrong when using computers. 

 

✅ Examples of Good Computer Ethics: 

●​ Don’t copy or use pirated software​
 

●​ Don’t hack into someone’s account​
 

●​ Don’t spread fake news or viruses​
 

●​ Don’t steal others’ work from websites​
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●​ Give credit to authors when using their data or images​

 

🧠 Simple Rule: If you won’t do it in real life, don’t do it online! 

 

🔹 7.8 Cybercrimes 

💡 What is Cybercrime? 

Cybercrime means crime done using computers or the internet. These are illegal activities 
done by hackers or criminals online. 

 

✅ Types of Cybercrimes: 

Type Description 

Hacking Breaking into someone’s system 

Phishing Sending fake emails to steal info 

Identity Theft Using someone’s personal info wrongly 

Spreading Malware Sending viruses to harm systems 

Cyberbullying Threatening or teasing others online 

 

✅ How to Stay Safe: 

●​ Don’t open unknown links or emails​
 

●​ Never share personal info with strangers​
 

●​ Use antivirus and update your system​
 

●​ Use two-step verification for accounts​
 

🛡️ Note: Cybercrimes are punishable by law in Pakistan and around the world. 
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🔹 7.9 Health Concerns of Computer Use 
Using computers for long periods can affect your health. It’s important to take care of your body 
and eyes while using computers. 

 

✅ Common Health Problems: 

Issue Cause Tip to Avoid 

Eyestrain Looking at screen too long Take breaks, use eye 
drops 

Back and Neck Pain Poor sitting posture Use a proper chair 

Headaches Too much screen time Reduce brightness 

Wrist Pain / RSI Typing for too long Use ergonomic keyboard 

Obesity / Weight Gain Sitting for hours Exercise regularly 

 

✅ Healthy Habits: 

●​ Take a 5-minute break every 30 minutes​
 

●​ Sit straight with a comfortable chair​
 

●​ Keep the screen at eye level​
 

●​ Blink your eyes often​
 

●​ Stretch and move around​
 

 

📌 Summary Table 

Topic Key Idea 

Information Privacy Keep personal data safe 

Computer Ethics Use computers honestly and respectfully 

125 

http://thetmnotes.com


Th
eT
mN
ote
s.c
om

Introduction to Information & Communication Technologies (ICT) By TheTmNotes.com 
 

 

Cybercrime Illegal computer use like hacking or scams 

Health Concerns Long computer use can affect eyes, back, 
etc. 
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